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Introduction

The eMaRC (Electronic Mapping, Reporting and Coding ) Plus software was initially developed for the
NPCR- Advancing E-cancer Reporting and Registry Operations' ePath Project by the Registry Plus
Development Team of the U.S. Centers for Disease Control and Prevention (CDC) in 2006. The eMaRC
Plus ePath (electronic Pathology) Reporting Module reads HL7 version 2.3.1 and 2.5.1 Observation
Result (ORU 01) message batch files, parses messages, and stores HL7 data elements as discrete field
values into tables in the Pathlab database. In a typical setting, the Public Health Information Network
Messaging System (PHINMS) is used to send securely HL7 batch files from a laboratory to a cancer
registry or some other agency working on the cancer registry’s behalf. The eMaRC Plus resides at a
cancer workstation and polls the worker queue of the PHINMS receiver for any new incoming files.
When a new file arrives in the queue, the application selects it based on the text containing cancer
terms, processes it, and then goes back in the waiting mode until another new file arrives. eMaRC Plus
ePath Reporting Module can be used in an interactive mode where the user manually selects a file to
import into the Pathlab database.

During import, eMaRC Plus uses a terms table to search reports for potential cancer cases. Additionally,
a built-in negation terms finder algorithm (NegEx) enhances the program’s text interpretation
capabilities by discriminating the cancer term when used in a negative manner. For example, patient
was determined not to have lymphoma, where lymphoma would be a cancer term searched for to
include as a cancer related report. The program shows imported pathology reports in the user readable
format with cancer terms highlighted in red and negated terms highlighted in blue. An administrator can
customize both the terms table and the negation phrases table.

eMaRC Plus also creates partial abstracts from HL7 version 2 messages during import, translating coded
values from the HL7 coding standard to the North American Association of Central Cancer Registries
(NAACCR) standards. It allows you to view pathology report data items from the HL7 message side-by-
side with abstract data items on the same screen. This allows you to look at the text of pathology
reports and code data items, such as primary site and histology, in partial abstracts. The autocode
histology feature suggests pertinent histology codes by analyzing the text of the report while the user
codes abstracts.

In June 2014, the CDC’s Cancer Surveillance Branch staff distributed the first production release of the
Physician Reporting Module as part of the eMaRC Plus application. The Physician Reporting module
imports HL7 Clinical Document Architecture (CDA) documents from physician office electronic health
record (EHR) or electronic medical record (EMR) as part of Stage 2 and Stage 3 Meaningful Use. The
documents can be imported manually or directly from a folder or the PHINMS queue, can be confirmed
to include the required data items, parsed for the HL7 documents, mapped and, if needed, can have the
HL7 data elements translated to NAACCR data elements.

Page 5 of 57



User Guide:
eMaRC Plus v7.0

Overview of User’s Guide

Through this manual, users will be introduced to eMaRC Plus ePath Reporting Module functionalities
and capabilities in a detailed, step by step manner. This manual provides information on tasks to be
performed by Registrar Users. For information regarding Administrator functionality, please see
document “Administrator’s Guide: eMaRC Plus” located on SharePoint.

eMaRC Plus displays pathology reports in a Workbench view, creating a side-by-side view of the

pathology report text with an automatically generated abstract to allow coding of primary site and
histology. Some data fields in the abstract will be prepopulated based on the submitted pathology
report, but users are allowed to override any automated decisions about reportability and coding.

This manual presents the information required by users of the eMaRC Plus system. The following
chapters of this manual cover the subjects that enable you to:

> Login to eMaRC Plus ePath Module.

» Use the features of eMaRC Plus to work with reports received in either Health Level Seven
International Standard (HL7) or pipe-delimited files by importing and processing batch files.

» Use functions within eMaRC Plus to review pathology reports and create abstracts for exporting

to the registry.

Pathalogy Lab

Batch Sernd Racaive
. L L Fl L
m E'E- ; Er -'Ilpm + m+

Mar-PHIRPAS Transpart

Manual Impart

Central Carcer Registry

PHIMBAS Impart

W
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Pipe-de=limited Fil=s
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eMaRC Plus Features

eMaRC Plus was developed to view and work with HL7 files. eMaRC Plus was developed collaboratively
by participants in the National Program of Cancer Registries - Advancing E-cancer Reporting and Registry
Operations' (NPCR-AERRO) ePath Pilot Project and programmed by the Registry Plus Development
Team.

The program includes functions to import HL7 files manually or directly from the PHINMS queue, test
messages for existence of required data items, parse HL7 files, and map HL7 data elements to NAACCR
data elements. eMaRC Plus also builds a pathology laboratory database, storing various HL7 data
elements as discrete field values into tables in the database. The program creates NAACCR formatted
abstract records from pathology reports during import into the pathology laboratory database. The
program searches a terms table to find potential report of cancer, and uses a negation terms finder
algorithm (NegEx) built in to enhance the program's text mining capabilities in terms of specificity.
eMaRC Plus provides a view of the pathology report text and a generated abstract side-by-side allowing
coding of primary site, histology, grade, behavior, and laterality. This allows the user to override any
automated decisions about reportability and coding.

System Requirements

eMaRC Plus program works with 64-bit Microsoft® Windows® operating systems on x86-compatible
processors. The minimum hardware requirements are the same as those of the Microsoft Windows
operating system used.

System requirements includes:

» Minimum Processor 1GHz, but recommended Intel i5 with 1.9GHz or better processor.
Microsoft operating system Window 7, 8 and 10 or newer; Windows Server 2012 or newer.
Minimum of 2 GB, but recommended 4 GB (or more) memory for improved user experience.
Latest version of Microsoft Internet Explorer (recommended).

A minimum of 200 MB free hard drive space is required, which excludes eMaRC Plus database.
Microsoft .NET Framework Version 4.5 Full Version or newer version.

Application comes with a default Microsoft Local Database for configuration and low budget
use. For enterprise/production use, it must be reconfigured to work with SQL Server 2012 or
newer version.

VVVVYYYVY

It is highly recommended to use a professional grade database server to avoid data loss (a database
hosted on separate server gives you a more reliable platform). It is strongly recommend to do a back-up
periodically.

User Support

For technical support via e-mail, contact cancerinformatics@cdc.gov.

The CDC Registry Plus Development group is funded primarily to support NPCR-funded state central
cancer registries. As a result, CDC helps state central cancer registries set up the software and perform
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basic customizations. CDC also provides periodic software updates and problem solving to the extent
available resources allow. CDC does not provide on-site services, and does not support hospitals, clinics,
laboratories, or other private users.

eMaRC Plus is intended for distribution to central cancer registries after as-needed customization by the
central registry. The state central registry or other institution using Registry Plus software should
provide all support to end users submitting data to the system.

State registry contact information can be found at the National Program of Cancer Registries Web site:

https://nccd.cdc.gov/dcpc Programs/index.aspx#/3.

Other users of eMaRC Plus will need to independently understand and maintain the software
application.
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Getting Started

Launching eMaRC Plus

Once installed, you can launch eMaRC Plus:

1. From the Start menu, select All Programs — Registry Plus —eMaRC Plus, and then eMaRC Plus.

R

. Registry Plus

-
CDA Validation Plus

eMaRC Plus

Launching eMaRC Plus

2. The Login dialog box appears for you to enter User ID and Password.
e The eMaRC Plus log-in dialog box will open.

e The Administrator now has an option to sign into the System Configuration from the initial

login dialog box.

eMaRC Plus n

User ID I
eMaRC PLUS == !
e Password I
Select Module IeF‘ath Reparting ;I
Version: 7.0.0.1
ﬁﬁﬁSystem Configuration J QK x Cancel |

National Proegram of Cancer Regisines (NPCR)
Centers for Disease Conirol and Prevention (CDC)

eMaRC Login dialog box.

3. Enter your eMaRC User name and Password and select ePath Reporting.

NOTE: Please contact an eMaRC Administrator to set up a User name and password for
your initial login.
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Changing Your Password

1. Select Administration>Manage User...
e The Manage User dialog box appears.

e

JOAN DOE 2dd ..
testuser
test Delete
Add/Remaove Roles ...
Change Password
Assign Facilities ...

User Mame:

User ID:

Roles

Ok

Manage User dialog box.

2. Select your name from the list of users and click Change Password.
e The Change Password dialog box opens.

o
JOHN DOE add..
testuser
test Delete
AddiRemove Roles
Facilities
Enter password E==n
|
Re-enter password
- o
&
ok

Change Password dialog box.

3. Typein your new password in the Enter password field and retype your password in the Re-

enter password field. The passwords must match, including capitalization and use of special
characters.

NOTE: Users are only permitted to change their own passwords. Only an eMaRC
Administrator can reset the password of another user.

4. Click Ok.
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eMaRC Plus Main Window

When a user successfully logs in to eMaRC Plus, the main window will open.

40 eMaRC Pius =] @ sl
File  Admnistration  Tools  Help. 1
- Eblmport HLT [ Import Pipe-delimited ~ Open batch &3 Export Abstracts (] PHINMS Queue - Search |, Show/HideList | Rew Dsta |= Reports

User: JOHN DOE. Datsbiase: eMaRCPius V60

eMaRC Plus main window.

The menu bar contains the following options:

| File Administration  Toels Help

eMaRC Plus menu bar.

Contains options commonly performed by users assigned a role of “Registrar” in eMaRC Plus.

File = Admini i Tools  Help
Impaort Pathology Reports Manually »
Poll and Import HL7 Batch File from PHINMS Queue
Poll and Impert HL7 Batch File from Folder
PHINMS Queue ...

Test HL7 Message for Missing Required ltems ...
Test Pipe-delimited File Format ...

Open Pathology Reports Batch ...

Export Abstracts ...

Review Held Reports ...

Search for Pathology Reports ...

Add Path Report Manually ...

Page Setup ...

Exit

eMaRC Plus File menu.
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Many of the options and functionalities in the Administration menu can only be performed when a user
is assigned an “Administrator” role in eMaRC Plus.

ai: eMaRC Plus
File | Administration | Tools Help

T 1 Manage Users ...

] Manage Roles ...
Manage Data Validation ...
Manage Error Handling ...
Manage Import Batches ...
Manage Messages ...
Manage Local Search Fields ...
Manage Fields in Search Result ...

Manage Facility ...
Manage eCC Rules

Manage Abstract Display ...

Manage HL7 Pathology Report Display ...

Manage Pipe-delimited Pathology Report Display ...
Manage Report Template ...

Manage Search Terms Table ...
Manage Site Confirmation Table ...
Manage Site Negation Table ...
Manage Maskterms table ...

Manage Hematopoietic Terms Table ...
Manage Pre-negation Terms Table ...

Manage Post-negation Terms Table ...

Application Configuration ...

View Audit Log ...

Remove Mon-reportables ...

Remove Mo-cancer Terms Reports ...
Remove Confirmed Duplicate Reports ...

Remove Confirmed Mot Needed Reports ...

eMaRC Plus Administration menu.

NOTE: Please see the Administrator Guide for eMaRC Plus located on SharePoint for more details
on functionalities available in the Administration menu options.

Contains the Bookmark options, which allows a user to save their spot and easily navigate back to a
report of interest.

a4 eMaRC Plus
File Administration Help
Tea Import HL7 & In Bockmark 3 Add Bookmark S Queue - Search I;;;}ShowIH\deList |~ RawData |= Reports

Go To/Manage Bookmark

eMaRC Plus Tool menu.

For more details on bookmarking reports, please see the Bookmark Reports section.
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Provides access to the online help system and a dialog box that displays the eMaRC Plus version.

2 eMaRC Plus

File Administration Tools

Zei Import HL7 % Import Pig User's Manual Abstracts Ei PHIMNMS Queue - Search ‘557.=._~ Show/Hide List |~ Raw Data = Reports

Adrinistrator's Manual

About

eMaRC Plus Help menu.

e User’s Manual: Opens the online User’s Manual for eMaRC Plus.
e Administrator’s Manual: Opens the online Administrator’s Manual for eMaRC Plus.
e About: Opens the About dialog box to view the current version of eMaRC Plus.

The Tool Bar contains shortcuts for commonly used eMaRC features. Many of the Tool Bar options can
also be found under the File menu.

%4 Import HL7 Z&4 Import Pipe-delimited | Open batch {4 Export Abstracts Ei PHIMNMS Queue - Search ,:E_.i\ Show/Hide List | Raw Data } Reports

eMaRC Plus Tool Bar.

The Tool Bar contains the following options:
e Import HL7 — same as the File menu Import Files Manually>HL7 ORU Message Format... option.

See Manually Import HL7 Messages section for more details.

e Import Pipe-delimited — same as the File menu Import Files Manually>Pipe Delimited Format...
option.

See Import Pipe-delimited section for more details.

e Open Batch —same as File menu Open Pathology Reports Batch... option.

See Open Batch View section for more details.

e Export Abstracts — same as File menu Export Abstracts... option.

See Export Abstracts and HL7 Messages section for more details

e PHINMS Queue — same as File menu PHINMS Queue... option.
e Search —same as the File menu Search for Pathology Reports... option.

See Searching for Pathology Reports section for more details.

e Show/Hide List — use with Workbench dialog box to show/hide the Search/Filter/List Reports pane.

See Filter/Search/Report List section for more details.

e Raw Data — displays the unformatted text of an HL7 ORU message that is open in the Pathology
Report Workbench.
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See Raw Data Button section for more details.

e Reports —runs reports on eMaRC pathology data and provides output in a .csv file.

See Reports Button section for more details.
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Importing Pathology Reports

Import HL7 Messages via HL7 Interface

Pathology reports are received via the HL7 Interface, where they are grouped into batches and queued.
To import reports into eMaRC Plus via the HL7 Interface:

PHINMS Queue

1. Select File>Poll and Import HL7 Batch File from PHINMS Queue.

a2 eMaRC Plus
Administration Tools  Help
Impert Pathology Reports Manually 4
Poll and Import HLT Batch File from PHINMS Queue
Poll and Import HLY Batch File from Felder
PHIMNMS Queue ...

Test HL7 Message for Missing Required Items ...
Test Pipe-delimited File Format ...

Open Pathology Reports Batch ..

Export Abstracts ...

Review Held Reports .....

Search for Pathology Reports ...

Add Path Report Manually ...

Page Setup ...

Exit

eMaRC Plus File menu option Poll and Import HL7 Batch File from PHINMS Queue.

e Reports will begin to import. Progress of the import is shown in the Import dialog box.

Elmpnrt I

Lab: 7/19/2012 4:03:28 PM
File: C:\eMaRCPlus-Test"\Archive CCO HL-7 Interface

Messages in the file

[

Abort

Import dialog box.

NOTE: Performance may be slower in the eMaRC application during import of batches.
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2. When reports have finished importing, click the Abort button in the dialog box to close the
Polled Import.

Waiting for new POLL _.

Click on Abort to cancel

Polled Import dialog box.

When the import is complete, new batches will be created containing the imported messages.

Folder Poll

1. Select File>Poll and Import HL7 Batch File from Folder.

File Administration Tools Help
Import Pathology Reports Manually b
Poll and Import HL7 Batch File from PHINMS Cueue
Poll and Import HL7 Batch File from Folder
PHINMS Queue...

Test HL7 Message for Missing Required [tems ...
Test Pipe-delimited File Format ...

Open Pathology Reports Batch ...

Export Abstracts ...

Review Held Reports .....

Search for Pathology Reports ...

Add Path Report Manually ...

Page Setup ...

Exit

eMaRC Plus File menu option Poll and Import HL7 Batch File from Folder.

e A Browse for Folder box will appear, select the correct folder and proceed.

Manually Import HL7 Messages

Messages are usually loaded automatically from the inbound HL7 interface. However, it may at some
point become necessary to load manually Pathology Reports from an HL7 file.

NOTE: privacy and security policies require that any HL7 files containing PHI be stored on a
secure drive.
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1. Select Import HL7 from the main eMaRC Tool Bar.

I£L=,i|ImportHL?Ié{:.l\mportPipe-delimited " Open batch 21 Export Abstracts [ PHINMS Queve - Search =, Show/Hide List | Raw Data |* Reports

eMaRC Plus Tool Bar option Import HL7.

e The Open dialog box opens.

2. Navigate to the file location of the HL7 message and click Open.

e Reports will begin to import. Progress of the import is shown in the Import dialog box.

When the import is complete, a new batch will be created containing the imported messages.
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Importing Pipe-delimited Pathology Reports

Import Pipe-delimited Messages via HL7 Interface

Pathology reports are received via the HL7 Interface, where they are grouped into batches and queued.

To import reports into eMaRC Plus via the HL7 Interface:

1. Select File>Import Pathology Report Manually>Pipe-delimited Format or select the Import

Pipe-delimited button from the main workbench dialog box.

File Administration Tools Help
Import Pathology Reports Manually > HLT7 ORU Message Format ...
Poll and Import HLT Batch File from PHINMS Queue Pipe-delimited Format ... |
Poll and Import HL7 Batch File from Folder
PHINMS Queue ...

Test HLT Message for Missing Required ltems ...
Test Pipe-delimited File Format ...

Open Pathology Reports Batch ...

Export Abstracts ...

Review Held Reports ...

Search for Pathology Reports ...

Add Path Report Manually ...

Page Setup ...

Exit

eMaRC Plus File menu option Import Pathology Reports Manually, Pipe-delimited Format

% Import LT % Import Pipe-delimited | Open batch 4 Export Abstracts PHINMS Queue - Search rﬂ Show/Hide List |~ Raw Data J=‘ Reports

Main Workbench Dialog Box, Import Pipe-delimited

The flowing Import Piped Delimited File dialog box appeatrs.

File: || Browse ...
Select date format in the file: |WMMDD ﬂ
Import | Cancel |

Import Pipe-delimited File box

2. Set the date format in the Select date format in the file: field. There are two formats for date:

YYYYMMDD and MMDDYYYY where Y — Year, M —Month and D — Day

3. Click the Browse... button. Result: the Open dialog box appears.
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4. Select a file from the list in the Open dialog box and click the Open button. Result: the Import
dialog box appears and displays the progress of the batch file being scanned and opened.

Lo Y |

Lab: 0700644713 :DIANON Systems Inc 924/2013 12:5%:24 PM
File: C:\Users\Barb\Documents\Test cases path [ab\MO2011ACANCREG - deidentified.

Importing ....12 of 20

Import dialog box — Pipe-delimited File

Page 19 of 57



Add Path Reports Manually

Add Path Report Manually

User Guide:
eMaRC Plus v7.0

Pathology reports that are not received via the HL7 Interface can be manually added; paper copies’ or
sent via secure transport can be converted and or scanned and saved as a PDF. Each path report will

need to be done individually and saved on a secure drive.

1. Select File>Add Path Report Manually> button from the main workbench dialog box.

File Administration Tools Help
Import Pathology Reports Manually >
Poll and Import HL7 Batch File from PHINMS Queue
Poll and Import HL7 Batch File from Folder
PHINMS Queue ...

Test HL7 Message for Missing Required ltems ...
‘ Test Pipe-delimited File Format ...

Open Pathology Reports Batch ...
1 Export Abstracts ...

| Review Held Reports .....

Search for Pathology Reports ...
Add Path Report Manually ...

| Page Setup ...

| Exit

eMaRC Plus File option Add Path Report Manually

2. Select Add>Browse and Select PDF File...
e Selected file will appear in Attachments Window

# File Administration  Tools Help - =
4 Import HL7 i Import Pipe-delimited || Open batch (i Export Abstracts 8| PHINMS Queue -~ Search |5, Show/Hide List | Row Data |~ Reports
[« mack]| » mexc & save
Fath Report Number  —— Reporting Facility ] T
Patient’a Laat Name Patients First Name ] Meoasage in. 1
Birth Date ——— Abstract Ref ID I
P - PATIENT IDENTIFICATION
—
—
B & =2 Q o —

— Name—middia | —
rame-maiden —
rame—Alias —

North American Association of Central A2, | mame—prerix —
> Cancer Registries. Inc. > Name—Suffix —
crore | Mame—Spouse/Parent | —
Standards for Cancer Registries 1| social security Number [
Volume V . Sex —
Date of Birth ——
Date of Birth Flag —
Age at Diagnasis —
Marital Status at Dx [
DEMOGRARHIC §
Addr at DX—No Street ]
Addr at DX—Supplemant | —
Adar at DX—~City .

User: JOHN DOE Database: DSDV-CHRO-W2K12\QSRV

Add Path Report Manually Display
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3. Select the file located in Attachments; manually abstract data from the pathology report and
select save.

W File  Administration  Tools  Help & =
* fih Import HLT 5 lmport Pipe-delimited || Open batch (i Export Abstracts 3l PHINMS Queue - Search |2, Show/Hide List | ~ Raw Data |~ Reports
[T« Back] » nexe | Esave [[]]
Path Report Number I Reporting Facility I I
Patients Last Name: I Patient’s First Name I Message ID  m
CEnE— | I —— Abstract Ref ID |
PATIENT IDENTIFICATION
e e Path Report Type 1 e
Mame—Last | ——
HMame-—First I
Mame—Middle l—
¢ | Mame-mMaiden |
Name—Alias |
L North American Association of Central 2, 1| Mame—Prenix |
Cancer Registries, Inc. Marme—Suffix |—
crore | Mame—Spouse/Farent | —
Standards for Cancer Registries ' social security NumBer I
Volume V Sex I
- Date of Birth | ——
Date of Birth Flag |
Age at Diagnosis | —
Marital Status at DX |
DEMOGRAPHIC S
Addr at DX--No Street |
Addr at DX—Supplement | —
Adar at DX-—-City | — -
< >

User: JOHN DOE Database: DSDV-CHRO-W2K121QSRV1

Add Path Report Manually Lab and Abstract Display

e Toremove a file selected the file located in the Attachments window and select Remove
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Open Pathology Reports

There are two ways to open Pathology Reports for viewing in eMaRC:

e Open Batch
e Search

Open Batch View

One way to view the Pathology Reports stored in eMaRC is to use the Open Batch option.

1. Inthe main window, click the Open Batch button.

% Import HL7 Je1 Import Pipe-defimited] || Open batchf & Export Abstracts PHINMS Queve - Search |=.-« Show/Hide List |~ Raw Data ]— Reports

eMaRC Plus Tool Bar option Open Batch.

e The Pathology Reports Batches window opens. Imported HL7 batches and Pipe-delimited
batches will be listed here.

NOTE: Only the last 100 reports are displayed by default in the Open Batch view. The
user has the option to select to view complete, review, specify number of batches, select
an import range, and select a batch range or to show all. Select choice and click Apply
Filter.

@ File  Administration Tools  Help

T Import HL7 1 Import Pipe-delimited |~ Open batch 4 Export Abstracts [{J PHINMS Cueue - Search [, Show/HideList | Row Data |- Reports

Last 100 batches are shown [ Show All

W Complete | Review [v Last [100  batches Import Dzte Range A A Batch 1D Betwen o) Spply Filter

“ File Administration Tools Help
& Import HL7 84 Import Pipe-delimited [ Open batch () Export Abstracts [ PHINMS Queue - Search [, Show/Hide List [~ Raw Data ]=|Reports

Last 100 batches are shown I Show All 42, Refresh

[V Complete W Review [ Last [200  batches Import Date Range  |_|_/_/__ _/_/_ Batch 1D Betwen T Apply Filter

-8 x

BaichiD | Fiename [Lab [ Import Date/Time [ Status [User  [#Repots [ #Review | #Hod [ # Followback | # Complete | # No cancertemns [ # Non+eportable | # Exported [ Type [
2 FloridaDepartmentofHealth. . Theranostix Inc."21D1058... 3/2/2018 Z1800FM  Complete doo 2 0 [ [ 2 [ 0 0 HL7ORU"1
20 HL7 Cases-20171212t¢ SIPARADIGM LLC"31D10. 3/2/2018 1:57:00 PM Review doe 2 2 0 0 0 0 0 0 HL70RU™
19 MLD_Example txt MLD Pathology"D1023456... 3/2/201812:13.00PM  Review toa 1 1 0 0 0 ] 0 0 HL7ORU"1
18 872 ProPath it PROPATH"45D0908675"..  3/2/201812:06:00 PM  Review toa 1 1 ] ] ] ] 0 0 HLTORU"
3 TFS_985_Colon_HighGrad. LONDON HEALTH SCIEN 1/29/2018 3:3500 PM  Complete doe 1 0 0 0 1 0 0 0 HL70RU™
2 721 Breast_laleraitybd  GRAND RIVER HOSPITA.. 1/28/2013200:00PM  Review doe: 3 3 ] ] 4 1 0 0 HL7ORU"

Pathology Reports Batches window.

The following information is displayed for each batch:

e Batch ID: the eMaRC Plus assigned number for the batch file.
e Filename: the filename of the batch file.
e Lab: the pathology lab that created the batch file.
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e Import Date/Time: the date and time the batch file was loaded into eMaRC Plus.

e Status: the current status of the batch file (Review, Complete).

e User: the user assigned (three character ID) to the batch file or None.

e # Reports: the number of reports contained in the batch file.

e # Review: the number of reports in the batch file with a Review status.

e #Hold: the number of reports of the batch file with a status of Hold.

e #iFollowback: the number of reports of the batch file with a status of Followback.

o # Complete: the number of reports in the batch file that have completed (saved) abstracts.

e # No cancer terms: the number of reports that eMaRC Plus has determined that contain no
cancer terms.

e # Non-reportable: the number of reports that have a status of non-reportable in the
selected batch file.

e # Exported: the number of reports that have been exported in the selected batch file.

e Type: the type of batch file (HL7 ORU”1 or Pipe-delimited).

2. Toview a report, double click on the batch you would like to open or highlight a batch click the
Open selected batch... button at the bottom left corner after selecting a batch.

Open selected batch ... Show Import Errors .. Export to Excel

Open Selected Batch option.

NOTE: Batches are sorted by Batch ID by default. To order batches by another column,
click the column label.

3. Click the Refresh button in the upper right corner to:
e Show any new batches in the Open Batch display.
e Recalculate the reports listed in the Reports columns (# Reports, # Review, # Hold, #
Followback, # Complete, # No cancer terms and # Non-reportable).

@ File Administiation Tools Help eI
& Import HL7 8 Import Pipe-delimited [~ Open batch {2 Export Abstracts E PHINMS Queue - Search =, Show/Hide List [~ RawData = Reports

Last 100 batches are shown. [™ Show All 42, Refresh

W Complete W Review [ Last [200  batches Import Date Range 7 77 BachiDBetwen [ To [ ApplyFilter

Refresh button option.

4. To view any errors encountered during import, select a batch from the Open Batch window and
click Show Import Errors... button at the bottom left corner after selecting a batch.

Open selected batch ... Show Impaort Errors ... Export to Bxcel

Show Import Error option.

5. To Export Open Batch Screen to Excel, select a batch from the Open Batch window and click
Export to Excel... button at the bottom left corner after selecting a batch.
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Open selected batch .. Show Import Errors ... Export to Excel

Open Batch Settings

An eMaRC User has the ability to modify the default Open Batch view to adjust the number of reports
and status of reports visible.

1. Click Open Batch tab...
e The Open Batch dialog box opens.

@k File Administration Tools Help

- 8 X
T Import HL7 & Import Pipe-delimited || Open batch {1 Export Abstracts [ PHINMS Queue - Search [E, Show/Hide List [~ RawData [= Reports

2, Refresh

Last 0 baiches are shown T Show All
W Complete W Review [ Last batches Import Date Range | /7 |__/_/_ BatchIDBetwen [T 7o [ appy Filer

BaichlD | Filename [ Lab
2

[ Import Date/Time [ Status [User  [#Repots [ #Review | #Hold [ # Followback | # Complete [ # No cancerters [ # Nonveportable [ # Exported |
FloridaDepartmentofHeatth .. Theranostix Inc. "21D1083.. 3/2/2018 21800FM  Complete doe 2 0 0 0 0
20 HL7 Cases-20171212tat SIPARADIGM LLC*31D10. 3/2/2018 1:57:00 PM Review doe 2 2 0 0 0 0 0
19 MLD_Example ixt MLD Pathology"D1023456... 3/2/2018 1213.00PM  Review toa 1 1 0 0 0 0 0 0
1 872_ProPath tct PROPATH45D0508676™.. 3/2/2013 120600FM  Review toa 1 1 0 0 0 0 0 0
3 TFS_385_Colon_Hghired... LONDON HEALTH SCIEN.. 1/28/2018 3:35:00PM  Complete doe 1 ] 0 0 1 0 0 0
2 721 Breast Lateralivt  GRANDRIVERHOSPITA.. 1/23/2018Z00:00PM  Review doe 8 3 0 0 4 1 0 0 HL7 ORU"1

Application Configuration dialog box — Import Setting tab.

2. By default, only the last 100 batches are shown. The user can choose one of the following

options;

e Complete: select this check box and click Apply Filter to view batches with zero reports for
review.

e Review: select this check box and click Apply Filter to view batches that need review.

e Last & Batches: check the last box and indicate in the batches box the number of batches
to review, click Apply Filter.

e Import Date Range: select a date range of batches and click Apply Filter.

[ ]

Batch ID Between: select a range of batches by ID and Apply Filter.

Searching for Pathology Reports

A second way to view the Pathology Reports stored in eMaRC is to use the Search option. The search
functionality allows you to search for all reports across all batches.

1. Click Search in the eMaRC Tool Bar.

EilmportHL7 T Import Pipe-delimited | Open batch [ Export Abstracts EiPHINMS Queve I:zSearch |} Show/Hide List | ~ Raw Data J Reports

eMaRC Plus Tool Bar option Search.
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o The following Search Window will appear.

% File Adminstiation Took Help S

B Import HLT 3 Import Pipe-delimited | Open bakch @ Esport Absiracts l PHINMS Cuewe - Search =, Showide List |~ Raw Data | Reparts

Patert | Focity | Dmemse | Repon St | Ackmrisote | Tt Seech | Custom Sesch fems |

Pathodagy Paport Number [ First Name Lt
Hedca e tubes | bt R N
oSy amber [————————
el
o ——

ZpfPostal Code: 1

Searen Cless 4l Sesech Poranaters T Exchude akder lnked repors rom resch Sove Query Open Saved Query

eMaRC Search Window.

2.  Enter your search criteria in one or more of the following tabs:

e Patient
e Facility
e Disease

e Report Status

e Administrative

e Text Search

e Custom Search Items

NOTE: Hover your mouse over a Search field for details on values allowed (e.g., some
search fields will allow comma separated, partial, or range values).

3.  Click Search to search for the pathology reports specific to the criteria you have typed.
Alternatively, you can hit Enter once you are finished entering your search criteria.
e Search results will be displayed in the Search Window.

Search Clear All Search Parameters ‘ ™" Exclude older linked reports from result P | Open Saved Query ..

12 reports found,

Msg Mo [ Message Type [ Base ID [ Batoh ID [ Pathiab 1D [ Ordering Facilty | Medical Record . | Specimen Date | Name-Last [ First Name Bith Date [ Social Securty [ Dx Cty Dx Stat [ BEHA A
Os HL7 2 3734 2013/09/06 0000 XOORRRX 99999999 XOOHROK XK 2

45 HL7 2 21D1058230 New Tampa Uno 201801112 X0 X0, YOO, X0 XK 2

O HL7 2 2101058230 Urology Instute ... XXXXX 2018/01/09 00K XK XK X000 X0 3
o4 HL7 2 31D102865% NYU Langone H... C17:02502 2017/05/03 LAST FIRST 19490730 Pine Brook ]
O40 HL7 2 311028659 Marvin Cooper, .. C17:04113 2017/06/22 LasT FIRST 19430730 Pine Brook M 3
O HL7 3 3850 2017/0316 FIRST LasT 19790101 3
O HL7 2 1982 2013/09/24 XK XX 99999999 XK KKK KK 1
O HL7 2 3932 2013/09/10 00K XHRRRK 99999999 X0K X< 3
Ou HL7 2 3850 2013/09/23 XXX XHXKXK 99539939 XK XXX 2
O HLT 2 1681 2013/09/24 000X XOHOO0XX 99999999 X000 XX 2
[miF] HL7 2 3587 2013/05/28 XHOU0UXK X000 99999999 XA XX 2 v
< >

Hold down the CTL and Click on Datagrid to select multiple messages

Open ‘ Export Abstracts Data Export to Excel Export to CSY &R Print Selected Reports Close

User: JOHN DOE Database: DSDV-CHRO-W2K124QSRV1

Select All

UnSelect All

eMaRC Search results.
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NOTE: To sort reports by a specific column, click the column label.

4. To open reports, select the checkbox to the left of the report and click Open. If you would like
to view all reports from the Search results, click Select All and then click Open.
e Atemporary batch will open containing the selected search results.
e To start a new search, click Clear All Search Parameters to clear all search criteria.

Saved Queries

If a user searches for the same information on multiple occasions, a query can be saved to reuse at
another time.

1. Enter the information into any of the 7 tabs.
2. Click the Save Query... button.
e The HL7Reader dialog box opens to enter name of saved query.

Enter 2 name for the saved queny
Cancel

Saved query name dialog box.

3. Enter the name of the query and click Ok.

1. Toopen asaved query, click the Open Saved Query... button.
e The Saved Queries dialog box opens.

Saved Queries dialog box.

2. Select the desired query from the list and click Open.
3. Inthe search window, click Search to execute the query.
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1. Todelete a saved query, click the Open Saved Query... button.
e The Saved Queries dialog box opens.
2. Select the desired query from the list and click Open.
3.  Click the Delete Selected button to remove the query from the list.

Search - AND/OR Searches

Grey boxes appear in some search tabs, grouping data items together.

e.g. Report Status tab:

Patient 1 Facility 1 Disease Report Status I.ﬁdmmistratwe Text Search | Custom Search tems ]

Select all status to searchitype Report Type
[~ Exported
[” Mon-reportable [~ Followback [ Test
™ Review [~ Hold ™ Hematopoietic I~ Linked
[~ Coded ™ Mo Cancer Terms Report

Report Status search tab.

e Processing Statuses are grouped together under the label “Select all status to search/type”.
e Report Types are grouped together under the label “Report Type”.

o Exported and Linked reports are grouped together separately from Processing Status and
Report Type.

When search fields appear within the same grouping box, the search will be an OR search.

e.g., In the Report Status/Type tab, the following search will provide results of reports that have a
Processing Status of “Review” or a Processing Status of “Complete”.

Patiert | Facity | Discase Report Staius | Adminisrative | Text Search | Custom Search fems |

Select all status to searchitype Report Type

I™ Exported
I Non-reportable I Followback I~ Test

W Review I™ Hold I~ Hematopoietic I™ Linked
[V Coded [~ Ne Cancer Terms Report

e.g. OR search.
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When search fields appear in different grouping boxes, the search will be an AND search.

e.g., In the Report Status/Type tab, the following search will provide results of reports that have both a
Processing Status of “Review” and a Report Type of “Hematopoietic”.

Patient ] Facility ] Disease Report Status ]Adm\nistratwe ] Text Search } Custom Search tems ]

Select all status to searchitype Report Type
[~ Exported
[ Mon-reportable [ Followback [ Test
¥ Review ™ Held W Hematopoietic [~ Linked
[ Coded [ Mo Cancer Terms Report

e.g. AND search.

Export Search Results

Results from the Search Window can be exported into an Excel file. The User also has the option to
Export the file out of eMaRC.

Export to Excel / CSV

1. Open the Search Window and perform desired search.
e Search results are populated in the Search Results Window.

2. Click the Export to Excel / Export to CSV button at the bottom of the Search Results window.

Msg No [ Message Type | Base ID [ Batch ID [ Pathiab 1D [ Ordering Faciity | Medical Record .. | Specimen Date | Name-Last [ Frst Name | Bith Date. [ Social Securty | Dx Gity [ Dx Stat [ BEHAY A
Os HL7 2 7% 2013/09/06 X0 XOO0000K 99999999 X 2

O HL7 2 2101058230 New Tampa Lo 2018/01/12 X00K HO0KK 000K H0KK KRR 2

[mES) HL7 2 21D1058230 Urology Instiute .. X0000C 2018/01/09 X000 X000 0004 X000 00X 3

O HL7 20 3101028659 NYU Langone H... C17-02902 2017/05/03 LasT FIRST 13430730 Pine Brook N

O HL7 0 3101028659 Marvin Cooper, .. C17:04119 201770822 LasT FIRST 18430730 Pine Brook " 3

o HL7 3 3850 2017/03/16 FIRST LAST 19790101 3

e HL7 2 1982 2013/08/24 JOOOCK XK 99999999 OO JHNAK XX 1

o5 HL7 2 392 2013/09/10 X000 KO0 99999999 XK XX 3

O HL? H 3850 20130823 XH0OKHK RO000C 99933599 KO0 00 2

O HL7 2 1681 201370924 00000 KOO0 99999999 HO000K X« 2

O HLY 2 3567 2013/05/28 XHCOGHRNK ®0K 93933599 KRR xx 2 v
< >

Hold down the CTL and Click on Datagrid to select multiple messages

Select All | UnSelect All

Open ‘ Export Abstracts Data

Bt ioExcl P Slocted epers e

Export to Excel / Export to CSV button in Search results.
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3. Choose location and name for file and click Save.
e Message appears: “Result has been exported to: [FILE LOCATION]”

4. Navigate to save location and open.

Export Abstract Data

1. Open the Search Window and perform desired search.
e Search results are populated in the Search Results Window.
2. Click the Export Abstract Data... button at the bottom of the Search Results window.

Msg No Message Type | Base ID Batch ID Pathiab ID Ordering Facilty | Medical Record ... | Specimen Date | Name-Last First Name Bith Date Social Securty .. | Dx Gty Dx Stat BEHA\ A
Os HL7 2 3734 2013/09/06 XXX SOOUORK 99393999 KGO X 2

Clas HL7 2 2101058230 New Tampa Uro 2018401712 HHRHK YOO XHHRK KHG0K KHRK 2

Cas HLT 2 2101058230 Urology Instiute .. XXXXX 201801709 XRXXK XK XXX KKK KRXRK 3

O« HL7 20 3101028659 NYU Langone H... C17:02902 2017/05/03 LAST FIRST 19490730 Fine Brook N

O HL? 20 31D102865% Marvin Cooper, ... C17:04119 2017/06/22 LAST FIRST 19450730 Fine Brook N 3

017 HL7 3 3850 2017/03/16 FIRST LAST 19790101 3

s HU 2 1982 201309724 XRXUK XOUO0K 99999999 KHGOR0K KKK XX 1

s HU 2 3932 2013409/10 XRXXX XRHRHX 99999999 KHRK, XX 3

[=mp% HL? 2 3850 20130923 XOOGK ROV 99999999 OGN X 2

[mRE] HL 2 1681 201309724 XHOUK BB 99399999 RHRA R 2

[mRH HL 2 3587 2013/05/28 KHHHHK KKK 99999999 HHVOHKK x 2 v
< >

Held down the CTL and Click on Datadrid to select multiple messages

Open ‘ IExpmAhmas Datz I Exportto Excel ‘ Export to CSV & Print Selected Reports Close

SelectAll | UnSelectAll

Export Abstract Data button in Search Results

3. Export Abstract dialog box will open, select and click export

" Export HLT messages only
" Export abstracts only
" Exports abstracts and associated HL7 messages

™ Mark abstracts as exported

Export Close

Search — Local Search Items

An Administrator can adjust the search fields in the Custom Search Items tab of the Search window.

1. Click Administration>Manage Local Search Fields
o The Select Search Fields dialog box opens.
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#i: Select Search Fields

Select fields to add to the Search window Selected search fields

Reporting Facility - HIM

Path Lab Name Path Ordering Facility Name
E-Path Date/Time Stamp Path Ordering Facility Mumber
Message control 1D Addr at DX-City

Processing |0 CLIA number

Encoding characters OBX2

Message type

Coding System

Field Separator Add
Version ID

CLIA number

Medical Record Number Remaove
Social Security Mumber

Name-Last

Name-First

Name-Middle

Birth Date

Sex

Name-Alias

Race 1

Addr at DXCity

Addr at DX-State i

m

Save Close

Relabel ...

Al

Local Search Items for selection.

e Columns in the right-hand column (Selected search fields column) will appear in the Custom

Search Items search tab.

2. Use the Add and Remove buttons to move data items to the Selected search fields column.

3. Use the up and down arrows to change the order of the data items in the Selected search fields

column.

4. Select a data item in the Selected search fields column and click Relabel... to change the name of

the data item displayed in the Search window.
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The view that displays the Pathology Reports in eMaRC Plus is referred to as the Workbench.

> eMaRC Plus - [epathworkbench 4/17/2018 9:58:28 AM, File: BOS-Cancer20110324090742test. b, Batch No: 347 - 1.of 5 e | @
ok File Administration Tools Help HE
[ Import HL7 [ Import Pipe-delimited | Open batch & Bxport Abstracts [ PHINMS Queue - Search =2, Show/HideList |~ RawData |=|Reports
« Back | » Next | Change Report Status @ Hold (& Follow-back |[_| Test Report @ HemeReport & Print Report Bllsave |3 Delete Abstract |3, Add Abstract [TINote  &§ “¥ eRE Map
Message ID: 1212 Path Report No: BLIIONS0005405 Sex:  SpecDate:  DMDB20T  Processing status: Complete Postact Ref D: 1183 |
@ Errors =
Message ID [1212
SH SEGMENT Abstract Ref ID [1183 3
Bostwick PATIENT IDENTIFICATION
Laboratories -
CLIA number: 3301062194  PathLabName:  Urology-Uniondal Message controlID: 2011032408580100016 Path Report Type 1 [01 Pathology |
E-Path DatefTime Encoding Name-—Last [onkwown
Reporting Faility: 3301062194 Stamp: 2010324085801 Processing ID: P characters:
[1 Message type: ORURO1 Coding System: LIA Field Separator: | emz=Fiml [
Version ID: 231
P e Name-—Middle [
Social Security Name-Maiden I
Number: 324344216 Name-Last: Name-first: Name.Middle:
Addrat DX Postal Name-—Alias I
Addr at DX.City: Addr at DX-State: Code:
Addrat DX-No & Wedical Record T [
g Number: Birth Date: sex: g
Name-Alias: Race 1: I
ORC SEGMENT Name-SpouseParent [
Path Ordering
Client/Phys Addr- Sex [3 Not Stated/Unknown =]
ity: ELKHORN
Social Security Number [r2e3a2216
[+] Show Report Date of Birth /.
Legend — =
Path Final Diagnosis Date of Birth Flag | Allor patt of date known OR date not collected |
Prostate Histology: MALIGNANT
Prosiate, NEEDLE BIOPSIES: Age at Diagnosis o5
(A)Right
e Marital Status at DX [6 Unknown 5
ADENOCARCINOMA (Gleason Score 3 +4 =7) INVOLVING 30% OF THE SPECIMEN (1 OF 5 CORES CONTAIN CANCER). Gleason Pattem 4
COMPRISES 10% OF THE CANCER. CANCER LENGTH 1.77 cm ELTERRTES
@1)Lett Addr at DX-No Street [onKNOWN
Benign prostatic issue. Adr at DX-Supplement I
Histology ICD.0-3: M-814032DENOCARCINGIA, NOSHCDOZ Ry Junnovny
Addr at DX-State [US United States. NOS (sate, et unknown) =l
Site ICD-0-3: CE19*Prostate, NOSHCDO3
Addr at DX-Postal Code [s99999859
+| | countyatox 555 A-

User: JOHN DOE Database: eMaRCPIus V60

eMaRC Plus Workbench.

When a pathology report is opened, there are two panes displayed by default. The left portion of the

Workbench Report Display is the Pathology Report and the right side of the dialog box is the Abstract to

be submitted to the registry. A third pane, the Filter/Search/Report List pane is hidden by default.

Pathology Report Pane

Functionalities in the Pathology Report are available in the following Tool Bar:

¢ Back | » Next Change Report Status |ighHold | & Follon-back DTertRepmt @ Heme Report

Pathology Report Tool Bar.

. Save |7 DeleteAbstract |7 Add Abstract |2 Note ,""eR[Ma
i 3 2 M P

The back and next buttons allow a user to navigate through the open batch of Pathology Reports.

«Back » Next | Change Renort Status | ighHold | & Follow-back | [ Test Report g Heme Report

Back and Next buttons.

_ bl Save {3 Delete Abstract | |5 Add Abstract || —INote: f"eREMap
= ] 0 &
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eMaRC uses search terms to determine automatically the reportability of a report. A user can override
the reportability decision made by eMaRC filters by using the Change Report Status button.

CBack |+ Nextf Change Report Status JidHold | Follow-back || Test Report 4 Heme Report C S J5Delete bstact {5 Add Abstract [INote | &) 7% eREMap

Change Report Status button.

To change the status of a report from Review to Non-reportable:

1. Open the report you would like to change and click the Change Report Status button.
e The Change Report Status Pathology Report dialog box will open.

Action

% Change status on pathology report o Nonreportable
" Change status on pathology report to No Cancer Terms
" Delete pathology report and associated abstracts

" Change status to review

Reason

Select reason why report status is changed:

Enter ather reason if net listed above:
I™" Add this reason to the list above for later use
Coce

Change Report Status dialog box.

2. From the dropdown menu, if desired, select a reason why the report status has changed. If an
appropriate reason is not listed in the dropdown menu, enter the reason in the “Enter other
reason if not listed above” text box and ensure the “Add this reason to the list above for later
use” checkbox is selected. The system does not require that a reason be entered to change the

status of a pathology report.

3. Ensure radio button is selected and click Ok.
e Processing status displayed at the top of the report will update to selected item.

NOTE: The Change Report Status button can also be used to change a report’s status
from a Non-Reportable to a positive cancer report (select “Change status to review”
radio button).

If you require a second opinion on a report, the Hold button can be used to assign a report for review
for another eMaRC user.

Back b Nt Change Report Statugl i Hold [ Folow-back DTestRepmt‘HemeReport g Har ]oDe\eteAbmd JQAddAhmm gNote @f:eﬁ[Map
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Hold button.

1. Open the report you would like to hold, and then click the Hold button.
e The Hold Report dialog box will open.

Select 3 user you want to hold this report to:
|JDHN DoE

2. Select the desired user from the list and click Ok.
e Thereportis now held for the assigned user and the Processing Status of the report is
updated.

Message ID: 45 Path Report No: THS18-09076 Sex: M Spec Date: 012208 IStatus: Held for DOE I

Updated Processing Status.

The Test Report flag can be used to identify the reports of special studies sent by a hospital. Reports
flagged as Test can be searched from the Report Status/Type tab of the search window.

CBack et Change Report Satus g Hold | @ Follow-back § Heme Repor . Hwe [3Deeedtra | J5idd bt [hcte & FeREMp

Test Report flag button.

1. When the report is open in the Workbench, click the Test Report button in the report tool bar.
e The Processing Status will update as follows:

Message |D: 45 Path Report Mo: THS18-09076 Sex: M Spec Date: 011272018 IF'rooessing status: Complete I

Test report Processing Status.

2. Open the Test Report you want to unflag and click the Test Report button in the report menu
bar.
o The following dialog box will open.
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This report has been marked as test report.
Do you want to unmark it?

Remove Test flag dialog box.

3. Click Yes to remove the Test flag.

eMaRC will automatically assign a Heme flag to reports containing applicable keywords for
hematopoietic reports. A user can also manually add or remove the Heme flag to a report.

Back | * Next | Change Report Status |ighHold & Follow-back UTe;tRepcI @ Heme Repot I I ]Save 15 Delte Abstrct {3 Add Abstact [~ Note | ) 2 eRE Nap

Heme Report flag button.

Manually Assign Heme Flag

If the Heme flag is not automatically assigned to a hematopoietic report, you can manually assign a
Heme flag.

1. When the reportis open in the Workbench, click the Heme Report button in the report tool
bar.
e The Processing Status will update as follows:

Message |D: 45 Fath Report Mo: THS18-09076 Sex: M Spec Date: 01122018 IStatua: Hematopoistic F{epc:-rtl

Heme report Processing Status.

If the Heme flag is assigned to a report that is not a hematopoietic report, you can manually remove the
Heme flag.

1. Openthe Heme report you want to unflag and click the Heme Report button in the report menu
bar.
o The following dialog box will open.
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This report has been marked as Hematopoietic report.
Do you want to unmark it?

Remove Heme flag dialog box.

2. Click Yes to remove the Heme flag.

To skip over to the next pathology report, click the follow back button. If this function is used, the
Processing Status will be changed to read “Follow back” marked in red.

( Back * Next Change Report Status i)HU\d 1 Fallow-back DTe;tRepurt @ Heme Report . B sive ]aDe\eteAb;tract ]DAddAbstrm @Nute f":eREMap

Follow-back button.

To print the report currently being displayed in the Workbench, click the Print Report button.

PICTURE GOES HERE

 Bad Nt | Change Reprt St |igdHold | @ Folon-back DTestReport‘HemeRepoI@PrintRepurt I Bsoe [ DeteAtut [5AddAbset | [Thote & ¥3eRENap

Print Report button.

The Duplicate/Consult button is a dropdown menu that will provide the user with a list of links to
Pathology Reports related to the current open report. This includes:

e Addendum/amendment reports

e Consult reports from a secondary hospital
e Testreports

e Duplicate reports

@ File . Administration Teols  Help
f&4 Import HL7  f& Import Pipe-delimited || Open batch {1 Export Abstracts [£J PHINMS Queue - Search |52, Show/Hide List | Raw Data |= Reports

4 Back » MNext Change Report Status @Hold 2 Follow-back DTest Report ‘HemeReport &F Print Reporl ﬁJDuplicate.f'Cnnsult - I

Message |D: 565 Path Report No: 15-11-001736 Sex: M Spec Date: 08/20v2015 Processing status: Follow-back

(@ Errors

Duplicate/Consult dropdown button.
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The Duplicate/Consult dropdown menu provides information about the related batch of reports. The list
of reports is ordered by Message ID.

e T o

@k File  Administration  Tools Help

T Import HL? T Import Pipe-delimited |~ Open batch ({1 Export Abstracts ] PHINMS Queue - Search [, Show/Hide List |~ RawData |= Reports
« Back | » Next Change Report Status |ighHold | (& Follow-back | [_| Test Report g Heme Report & Print Report |7 Duplicate/Consult + [B save | |3 Delete Abstract | |, Add Abstract |[TINote  &h #3 eRE Map
* -0105-00048520r4 o c 619 &
Message ID: 3 Path Report No. BL11-0105-0004852 Sex:  SpecDals: 03022011  Prooessing status: Cor g LR ML TEF L S iginal 3 (D) CRTE G
1 Duplicate/Consult)no4g52archive Unprocessed Complete C613 8140/3 0

Duplicate/Consult dropdown list.

e Message ID: The 1st column indicates the Message ID assigned by eMaRC.
o Starred Reports: Indicate the report is flagged as the original report.
o Check-marked Reports: Indicate the current report open in the Workbench.
e Current Diagnosis Accession Number: The 2nd column indicates the Accession Number
(Specimen Number) assigned by the diagnosing facility.
o Duplicate Flag upon Import: The 3rd column indicates the Duplicate Flag assigned by eMaRC.
o Duplicate Flag by User: The 4th column indicates the Duplicate Flag assigned by a user (please
see Assigning a Duplicate Flag section for more details).
e Processing Status: The 5th column indicates the processing status assigned to the report by
eMaRC (can be manually changed through the Non-Reportable button).
e ICD-0-3 Coding Values: If the report has been coded, the Site, Histology and Behavior ICD-O-3
codes will be visible in the 6th and 7th columns.

Duplicate/Consult Window

Clicking on any of the reports in the Duplicate/Consult dropdown menu will open a new window. This
window contains a batch of all the related reports so you can browse between them easily.

The Duplicate/Consult window contains many of the same functionalities as the Pathology Workbench
window. Please see Pathology Report Pane section for details on functionality.

Users can assign a flag to each linked report to indicate the relationship between the reports.

Cument Hag
" Duplicate " Test " Addendum = Not Needed

" Unlink A i i G i " New Original Save Hag and Close

Duplicate Flag options in Linked Report window.

To set the duplicate flag, select the flag you wish to set and click Save Flag and Close.
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NOTE: Clicking Save Flag and Close will close the Duplicate/Consult Window. If there are
other changes that need to be made to the report (e.g. updating abstract), please make
these changes before updating the Duplicate Flag.

If there is an error in a report, an Error icon will appear at the top right of the report body panel. An
Administrator can set the validation rules to identify errors on import (see eMaRC Plus Administrator
Guide for more details).

> eMaRC Plus - [epathworkbench 3/2/2018 2:18:00 PM, File: FloridaDepartmentofHealth_2 .t

# File Administration Tools Help

Z4 Import HL7 5 Import Pipe-delimited | Open batch 4 Export Abstracts [ PHINMS Queue - Search [, Show/Hide List | ~ Raw Data |= Repo

+ Back | » Next | Change Report Status ighHold | (& Follow-back  [_| Test Report g} Heme Report & Print Report

Message |D: 45 Path Report No: THS518-09076 Sex: M Spec Date: 0122018 Status: Complete

I ;é Errors

Pathology Report Errors button.

Clicking the Errors button will open a dialog box listing any errors that are caused by invalid or missing
mandatory segments in the HL-7 message.

B3 Batch ID: 0 — O X

Mezsage Filter: - =]

MessagelD | PathReportNumbe | Sending Facility | Message

[ 45 THS18-09076 Theranostix Inc."2  Missing reguired data item: OBR.32.1.4 (Path
45 THS18-03076 Theranestix Inc.”2  Missing required data item: OBR.32.1.5 (Path
Error dialog box

Errors can be filtered by type by selecting one of the following options from the Message Filter
dropdown menu:

e Data item validation

e Missing required data items
e Length validation

e Segment/message errors

To view the raw HL-7 message sent by the hospital:
1. Click the Raw Data button located in the main eMaRC toolbar.
& Import HL7 - &4 Import Pipe-delimited | Open batch & Export Abstracts ﬁ PHINMS Queue -~ Search |=._¢ Show/Hide ListI " Raw D‘atai ]—‘ Reports
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Raw Data button.

e The HL7 message will be opened in a new window.

NOTE: To search for a term within the raw HL-7 message, click the Find... button and
enter the desired search.

2 Raw Data - HL7 format = (] x

Find Show ASCII

SH|*~\&|VitalAxis|Theranostix Inc.”21D1058230~CLIA|FCDS|Florida Department A
BID| 1| XKKXK |~ MR~ 455w~ A BT | KEKKK | KKK KKEEK " | | XEEHK | M| | | KKK KEKED
ORCIREI[IIIIIIIIITI1111]]INew Tampa Urology*~10D1004387~~~CLIA|5332 Primro:
OBR|1||THS18-09076|11529-5"5urgical Pathology Study Report LN||[2018011210(
OBX|1|TX|22633-2"Path report.site of origin“LN|1|Left Lateral Base|||A[]||F
OBX|2|TX|22637-3"Path report.final diagnosis”LN|1|A:Left Lateral Base:Need]
CBX|3|TX|22633-2"Path report.site of origin®LN|Z|Left Lateral Mid|||&|||F|
OBX|4|TX|22637-3"Path report.final diagnosis”LN|Z|B:Left Lateral Mid:Needls
OBX|5|TX|22633-2"Path report.site of origin®LN|3|Left Lateral &pex|||&[|[|F
OBX|6|TX|22637-3"Path report.final diagnosis~LN|3|C:Left Lateral Apex:Need]
OBX|7|TX|22633-2"Path report.site of origin“LN|4|Left Base|||A[[|F]]|20180]
OBX|8|TX|22637-3"Path report.final diagnosis"”LN|4|D:Left Base:Needle Biops:
OBX|9|TX|22633-2"Path report.site of origin®LN|5|Left Mid|||&[|[[F]]|201801]
OBX|10|TX|22637-3"Path report.final diagnosis“LN|5|E:Left Mid:Needle Biops)
OBX|11|TX|22633-2"Path report.site of origin“LM|6|Left Apex|||&]||F|||2018¢
OBX|12|TX|22637-3"Path report.final diagnosis”LN|&|F:Left Apex:Needle Biop: ¥
< >

MSH Close

Unprocessed HL7 message.

eMaRC Plus automatically scans and highlights certain words and phrases for enhanced readability. This
allows you to recognize easily important text. These words and phrases are identified by color in the text
of the pathology report pane. The legend is collapsed by default.

[+] Show Report
Legend

Collapsed Report Legend.

1. Click [+] Show Report Legend to show the legend.

Legend for Highlights

Red: Histology/Reportable Term

Blue: Megated Histology/Reportable Term
Green: Mon-reportable Skin Term
Mangenta: Site Term

Purple: Grade Term

Displayed Report Legend.

2. Click [-] Hide Report Legend to collapse the legend again.
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Abstract Pane

The Abstract contains information regarding the Pathology Report that will be sent to the Cancer
Registry. Information about the patient and facility will be extracted from the HL7 message and

populated into the Abstract. However, any of the information in the abstract can be manually
overwritten by a Registrar.

e Fillin all required fields in the Data to be Coded section of the Abstract Pane.

o Use the look-up feature to find a code for fields with the Search button A to the right of the

coding field.
e Use the drop-down lists to select values for the fields with the drop-down button
| ]
B save
e Complete the abstract by clicking the Save button .
e Use the Add Abstract button IgAdd Abstract to add multiple abstracts to the report (for a report

with multiple primary tumors).

e Patient and facility information will be automatically populated into secondary Abstracts from
the HL7 message.

JO Delete Abstract .
e Use the Delete Abstract button to remove multiple abstracts of the report.

e Add a Note to the abstract to make a comment about the report.

If there are multiple disease site terms within the report, for instance if both Oropharynx and Tonsil are
present, you can place your cursor on the bottom left corner or the primary site field and eMaRC Plus
will suggest sites for you to choose as shown below. Select one of the suggested sites from the list, to
populate the code into the coding field.

Abetract Red 1D: 170
DATA TO BE CODED

Primary St¢ [cosd s
|
Histologic Type 1C0-0-3  [501 Suggested sites
! ~10 AR
Behavior Code ICO-0-3  [3 9 109 - Oropharynx
) CO99 - Toasil
{ 3
Lateralty 0 Noroporoow: Ly
<
Grade {9 Grade or ool type not detesswred. not stated. of rot appiicatle »
Suggested sites
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Site-Specific Data Items (SSDIs) have been added to the display for cases diagnosed 2018 or newer.
When a diagnosed case of 2018 or newer is imported and field values are relevant it will auto-populate
with the correct Schema Id and applicable SSDIs.

Example of Prostate Case with values to produce a valid Schema Id & Applicable SSDIs

+] Show Report - CANCER IDENTIFICATION
Legend ~

Path Final Diagnosis Date of Diagnosis ’7
Prostate Histology: MALIGNANT o 2018/03/08
Prostate, NEEDLE BIOPSIES: Text-Primary Site Title
(A1) Right
MALIGNANT Prostate gland
ADENOCARCINOMA (Gleason Scare 3 + 4 = 7) INVOLVING 30% OF THE SPECIMEN (1 OF 5 CORES CONTAIN
CANCER). Gleason Pattern 4 COMPRISES 10% OF THE CANCER. CANCER LENGTH 1.77 cm
(B1) Left
Beniagn Primary Site J| |C819 - Prostate gland
Benign prostatic tissue. J rostaie gan
Laterality [0 Notapaiedste  +|

Histology ICD-0-3: M-81403"ADENOCARCINONA, NOSYCDO3 y
Text-Histology Title

Site ICD-0-3: C618"Prostaie, NOS*CDO3 Adenocarcinoma, NOS

Path Text Diagnosis Histologic Type ICD-0-3 2| |8140 - Adenocarcinoma, NOS
Path Clinical History Behavior Code ICD-0-3 3 Malignart, primary site -
Provided ICD-9 codes: 790.93. PSA 5.920 ng/ml. Date 2/22/11. DRE: Abnormal Grade = Grade I moderately dfferertial =

v

Path Nature of Specimen
Prostate Biopsy

<

Schema ID

- STAGE/PROGNOSTIC FACTORS
AJCCID = |

Schema ID =| Jooseo

Applicable SSDI’s

- SITE-SPECIFIC DATA ITEM (55DI1)

Prostate Pathological Extension J ’7
PSA (Prostatic Specific Antigen) Lab Value J ’7
Number of Cores Positive J ’7
Mumber of Cores Examined J ’7
Gleason Score Clinical J ’7
Gleason Patterns Clinical J ’7
Gleason Score Pathological J ’7
Gleason Patterns Pathological J ’7
Gleason Tertiary Pattern J ’7

NOTE: When the user makes a change to the Date, Primary Site or Histology they will also need to select
to have the Schema Id re-pulled for the applicable SSDIs to clear and reset.

Page 40 of 57




Abstract Field Properties

User Guide:
eMaRC Plus v7.0

eMaRC Plus allows the user to configure the Abstract view in order to customize the display. These
properties will be displayed for all eMaRC users.

1.

Available NAACCR Type A Fields

Click Administration>Manage Abstract Display...
The Select Abstract Fields for View dialog box appears.

-t
2 Select Abstract Fields for View X

Selected fields for abstract display

Accession Number-Hosp (550)
Active Faollow-Up Date (3000)
Addn|DsFreeDat SrcUsd (8009)
AddniDsFreeStatus (3007)

Addr at DX~Country (102)
Ambiguous Teminology DX (442)
Archive FIN (3100)

BCR-ABL Cytogen Date Flag (3902)
BCR-ABL Cytogenetic (3900)
BCR-ABL Cytogenetic Date (3901)
BCR-ABL FISH (5903)

BCR-ABL FISH Date (9504}
BCR-ABL FISH Date Flag (3305)
BCR-ABL RT-PCR Gual (9306)
BCR-ABL RT-PCR Qual Date (3907)
BCR-ABL RT-PCR Qual DtFlg (3508)

~

N
_<

Section Headers

DATA TO BE CODED
DEMOGRAPHICS

DIAGNOSIS

TEXT FIELDS

PATIENT IDENTIFICATION
CANCER IDENTIFICATION
STAGE/PROGNOSTIC FACTORS
FACILITY SPECIFIC INFORMATION
TREATMENT - 15T COURSE
FOLLOW UP/DEATH

SYSTEM FIELDS

Add Section Delete Section

|
_<

PATIENT IDENTIFICATION
Path Report Type 1(7480)- OBR 4.1
Name-Last (2230) - PID.5.1.r. d = UNKNOWN
Name—First (2240)- PID.5.2, r
Name-Middle (2250) - PID 5.3
Name-Maiden (2350)
MName-Alias (2280) - PID.9
Mame—Prefix (2260)
Name-Suffix (2270)
Name-Spouse/Parent (2290)
Social Security Number (2320) - PID 3.1, r, d = 559599559
Sex (220)-PID.8,rd=9
Date of Bith (240} - PID.7
Date of Birth Flag (241)
Age at Diagnosis (230) . r,d = 339
Marital Status at DX (150)- PID.161,d =9

DEMOGRAPHICS
Addr at DX-No & Street (2330) - PID.11.1, 1, d = UNKNOWI
Addr at D¥-Supplementl {2335)
Addr at DX-City (70} - PID.11.3, r.d = UNKNOWN
Addr at DX-5tate (80)-PID.11.4,r,d = US
Addr at DX-Postal Code (100) - PID.11.5, r, d = 5595599559
County at DX (30} . r,d = 999
Addr Cument-No & Street (2350) . d = UNKNOWN
Addr Cument—Supplement| {2355)
Addr Cument-City (1810) . d = UKNOWN
Addr Cumrent-State (1820) , d = US
Addr Current—Postal Code (1830) , d = 9999559959
Addr Cument-Country (1832) . d = USA
County-Currertt (1840) . d = 95%
Telephone {2360) - PID.13.1. d = 9999999399

Save Cancel

~

Properties

=]

_= |
= |

v

Select Abstract Fields for View dialog box.

2.
to and click Properties.

The Field Properties dialog box appears.

In the Selected fields for abstract display column, highlight the field you want to make changes

Fore Color NN ~ic: .
Back Color | Pick

Default value |

=l

™ Protected ™ Required

Cancel

I Invisible

Field Properties dialog box.

3. Adjust the properties as required:

necessary).

Fore Color: Adjusts the font color of the field.
Back Color: Adjusts the background color of the field.
Default Value: Sets a default value to the field (which can be changed in the abstract, if

Required: When this checkbox is selected, the field is considered a “Critical Field”. The

report will not be marked as Complete while this field is blank.
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e Protected: When this checkbox is selected, the field is considered “Protected”. The user will
not be able to enter data or change data into this field.

e Invisible: When this checkbox is selected, the field is considered “Invisible”. This field will no
longer be in the abstract view to enter data. This field can only be viewed in “Manage

Abstract Display”:

Available NAACCR Type A Fields

Selected fields for abstract display

Accession Number—Hosp (550)
Active Follow-Up Date (3000)
AddnlDsFreeDatSrclsd (8005}
AddnlDsFreeStatus (3007)

Addr at DX-Country (102}
Ambiguous Terminology DX (442)
Archive FIN (3100)

BCR-ABL Cytogen Date Flag (3902)
BCR-ABL Cytogenetic (3900}
BCR-ABL Cytogenetic Date (3301)
BCR-ABL FISH (3303)

BCR-ABL FISH Date (3904)
BCR-ABL FISH Date Flag (9905)
BCR-ABL RT-PCR Qual (3906)
BCR-ABL RT-PCR Qual Date (3507)
BCR-ABL RT-PCR Qual DtFg (3508)

Section Headers

~

v

DATA TO BE CODED
DEMOGRAPHICS

DIAGNOSIS

TEXT FIELDS

FATIENT IDENTIFICATION
CANCER IDENTIFICATION
STAGE/PROGNOSTIC FACTORS
FACILITY SPECIFIC INFORMATION
TREATMENT - 15T COURSE
FOLLOW UP/DEATH

SYSTEM FIELDS

|
_< |

|
_< |

Cause Of Death (1910), d = 0000 ~
Autopsy (1920)
ICD Revision Mumber (1920) .d = 0
Following Registry (2440)
Physician—Follow-Up (2470) - PV1.8.1
NP|-Physician—Follow-Up (2475) - PV1.8.1
Institution Refered From (2410
NPI-Inst Refemed From (2415)
Institution Refered To (2420)
NPI-Inst Refered To (2425)
Physician—Primary Surg (2480) - 0BR.10.1
NP|-Physician—Prim Surg (2485) - OBR.10.1
SYSTEM FIELDS
Date Case Report Loaded (2112)
Date Case Completed (2090) , p
Date Case Last Changed (2100}

Properties .

-

" o
.p.i.d=eMaRC5.3

A ’
Follow-Up Source (1790) . d =9
Follow-Up Source Central (1791),d = 89
IC0-0-3 Conversion Flag (2116) . p.i.d =0
Race Coding Sys—Cument (170) . p.i.d=7
Race Coding Sys—Onginal (180).p.i.d=7
Site Coding Sys—Cument (450) , p,i,d =

Morph Coding Sys—Cuent (470} .
Morph Coding Sys-Originl (480}, p.i.d = 8

R¥ Coding System-Current (1460}, p.i.d =06

Record Type (10) .p.i.d = A

MNAACCR Record Version (50) , p,i,d = 150 A

Add Section Delete Section
Save Cancel

Select Abstract Fields for View dialog box selected; protected and invisible.

Filter/Search/Report List

There is a third portion of the Workbench that is closed by default — the Filter/Search/Report List. This
pane contains a list of reports within the open batch and provides important options to view the
different types of reports contained in the batch file.

To view this list, either:

1. Click Show/Hide List in the eMaRC Tool Bar.

e eMaRC Plus

File Administration Teols Help
Zea Import HLT  J& Import Pipe-delimited | Open batch {2 Export Abstracts PHINMS Queue - Search |=,__? Show/Hide List | = Raw Data ;E Reports

Show/Hide List button.

e Click the small black right arrow (>) in the left border of the pathology report pane.
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{5H SEGMENT
2071298-
CLIA number: 2101058230 Path Lab Name: TheranostixInc. Message control ID: 18937432
[PID SEGMENT
Medical Record Social Security
L Number: HOOO Number: Hame-Last: JOGOK
Name-First. JOOC0( Name-Middle: Ethnic Group:
Race 1:
Expansion arrow.
The Workbench will now show 3 panes:
“k& File Administration Tools Help - & x
4 Import HL7 &2 Import Pipe-delimited |~ Open batch (5 Export Abstracts [ PHINMS Queue - Search |, Show/Hide List |~ Raw Data |= Reports
v I~ ShowToolip |- ¢ Back | » Next Change Report Status g Hold | & Follow-back | [_| Test Report _  Bllsave | |z Delete Abstract | |3 Add Abstract |[Z] Note
Path Report Nu... | Last Name | First Name | Sex | Spec Date | Message ID: 44 Path Report No: THY18-09271 Sex: M Spec Date: lpbstract Ref D 231
THY18-0%271 XXAKXX XXXXX ] 01/09/201 P
THS18-09076 KXXXX KXXXX M 01127201 Message ID 44
5 A Abstract Ref ID 23
CLIA number: 2101058230 Path Lab Name: Theranostix Inc. PATIENT IDENTIFICATION
2071298 ,—4|
Message control ID: 189374582 SRR s
Mame—L ast XK
Medical Record Social Security
< Humber: 000K Number: Name-—First K000
Name-Last: K0KX Name-First: 00000
Name-Middie: Ethnic Group: Hame-Hiidale
Race 1: Name-Maiden li

3 panes displayed in Pathology Report Workbench view.

A user can search for a report within the batch by clicking on the Search icon 4 in the
Filter/Search/Report List.

[ Show Tooltip
Path Report Nu... | Last Name First Name | Sex | Spec Date
THY1809271 000, 00K M 01/09/201
TH518-05076 EEEL RO M 0127201

Search button in the Filter/Search/Report List.

A user can filter reports by report type by clicking on the Filter icon \'d in the Filter/Search/Report List.

#h| 7 [~ Show Tooltip

Path Report Nu... | Last Mame | First Name | Sex | Spec Date

THY18-09271 HHHHK HHHHK M 01/09/201

THS13-05076 LR SO, M 01127201
Filter button in the Filter/Search/Report List
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Users can select the types of reports they would like to see within the open batch and are able to save
their preferences using the Reports Filter dialog box.

2 Reports Filter X

Select pathology reporiz with the followng status
Iv Review
v Held
W Complete W Hematopoietic
Iv Follow-back | Test

[v Mon-reportable W Mo cancer terms

Apply filter
~

" Apply filter next time batch is opened

v Save my preference

Ok | Cancel

—Reports filter dialog box

Another function you can enable is Show Tooltip.

ih 7 u ShchooItipl

Path Report Nu... | Last Name First Name | Sex | Spec Date

THY18-09271 L PR M 01/09/20
TH518-03076 Pt P M 0127201

Show Tooltip button in the Filter/Search/Report List.

Once you have selected the Show Tooltip, you have the ability to move your cursor above any pathology
report and a box will display all the associated information to the pathology report. If you do not have
this functionality turned on, you can alternatively scroll on the horizontal bar at the bottom of the panel
to view all the associated information to the pathology report.
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m eMaRC Plus - [epathworkbench

3/2/2

018 2:18:00 PM, File: FloridaDepartmentofHealth_2.t«t, Batch No: 22 - 1 of 2]

o File

Administration

Tools

Help

Import HL7 Import Pipe-delimited | Open batch {4 Export Abstracts PHINMSQueue + Search anr Show/H

i v ¥ Show Tooltip 4 Back | » Next @ Change Report Status |yt
Path Report Nu... | Last Name | First Name | Sex | Spec Date Meszage [D: 44 Path Report No: THY1&
THY18-05271 KRR KHHHK M 01/09/2M
THS518-03076 PO YOO M
Path Report Mumber : TH518-09076
Last Narne : 30000 |
First Marme : )OO0 1
Sex: M
Spec Date: 01/12/2018
Process Status: 1-Complete |
Reportability at lmport : -Complete ‘
Site Autocode Status : 4 - CTR overwrite of narrative auto-code [
Histology Autocode Status : 1 - Marrative report auto-coded by EMERC!
Behavior Autocode Status : 1 - Marrative report aute-coded by eMaRC |
Tooltip display in the Filter/Search/Report List.

Pathology Report Display Style

Each user has the ability to personalize the display of the Pathology Report to their individual
preference.

A user can alter the Display Style of the report in the Workbench display window.

1. Click Administration>Manage HL7 Pathology Report Display...
The Build Display Style dialog box will appear.

2 Build Pathology Display X
Build Display Style ...

Selected Pathology Fields for Display

MSH Segment
MSH.42
MSH.4.1
MSH.7

FID Segment
FID31
FID31

Reporting Facility
Path Lab Name
Date Case Report Received
Message control ID
Processing ID
Encading characters
Message type
Coding System

Field Separator
Version 1D

CLIA number
PathLabName

Path Lab Name

Medical Record Number
Social Security Number
Name-Last

Name-First
Name-Middle

Birth Date

Sex

Name-Alias

Race 1

Addr at DXCity

Addr at DX-State

Addr at DX Postal Code
Addr at DX-No & Street
Address Type Code

Telephane hd

MSH Segment
MSH.4.2
MSH.4.1
MSH.10

PID Segment
PID3.1
PID3.1
PID5.1

ORC Segment
ORC21.1
ORC.221

OBR Segment
OBR.16.3
0OBR.16.21
0OBR3212
0OBR3213

TXT Segment

CLIA number
Fath Lab Name
Message control 1D

Medical Record Number
Social Security Number
Name-Last

Name-First
Name-Middle

Ethnic Group

Race 1

_= |
_= |

ltem-specific Style ...

Fath Ordering Facility Name
Fath Ordering Fac Addr-No & St

Path Ordering Client./Phys-First Name
Path Ordering Client/Phys-Last Name
Pathologist Last Name
Pathologist First Name

Path Final Diagnosis

Path Text Diagnosis

Path Clinical History

Path Mature of Specimen
Path Gross Pathology

Path Micro Pathology

Path Comment Section
Path Supplemental Reports

Save Cancel

Build Pathology Display dialog box.
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2. Click Build Display Style...
e The Display Style dialog box will appear.

iWorkbend‘ Pathology Display Sin!| Linked Pathology Report Display Style |

~Body Style
Back Color  [\Wheat ~|  FemtColor  [gick =
Font [Asal = Font Size W
Style:
Margin Top  [1px Margin Bottom | 1px Margin Left  [1px Margin Right |1px
Back Color INEW ;I Font Color IWhlte ;I
Font I'ﬂmes New Roman ;I Font Size W
Display Style [fnine =T Hide
i Dataltem
Margin Top |1px Margin Bottom: | 1px Margin Left  |Tpx Margin Right  [1px
Item Header Style
Back Color Iw}]em j Font Color IBIack LI
Fant |Aial | FontSize [i2px
Width [z
ltem Value
Back Color  [Wheat =] FontColor  [Black ~|
Font [Avial | FomSze [z
\width |12[b,
i Text Sechion
™ Highlight Negated Terms
_swe | cacul |

Display Style dialog box.

3. Ensure that Workbench Pathology Display Style tab is highlighted.
e Adjust the settings to your personal preference.

Body Style: Controls the background of the report.
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MSH SEGMENT
2071298-
CLIA number: 2101058230 Path Lab Name: Theranostix Inc. Message control ID: 18937482
Medical Record Social Security
. Number: 20000 Humber: Hame-Last: 0000
Hame-First: OO Name-Middle: Ethnic Group:
Race 1
ORC SEGMENT
Path Ordering Urology Institute  Path Ordering Fac 2850 SE 3rd
Facility Name: of Central Florida Addr--No & St Court
Path Ordering Path Ordering
Client/Phys-First Client/Phys-Last Pathologist Last
Name: Charles Name: King Hame: Kalantarpour,
Pathologist First
Name: Fatemeh

+] Show Report

Legend

Path Final Diagnosis

ABladder Wash:Bladder Wash:urine Cytology Diagnosis :CARCINOMA, UROTHELIAL; Adequate cellularity for evaluation.

ABladder Wash:Eladder Wash:Fish Diagnosis :Positive; The UroVysion FISH study detected a positive profile. UroVysion FISH evaluates
chromosomes 3, 7, 17, and 8p21 for aneuploid and deletion events associated with urothelial cell CARCIMNOMA. 934 cells were analyzed in this
evaluation. Evidence of aneuploidy in at least 321 cells and evidence of 9p21 deletion in atleast 11 cells were found. These findings should be
correlated with cystoscopy results.

Path Text Diagnosis
Path Clinical History
CE7 8 MALIGNANT MEOPLASM of overlapping sites of Bladder/9CDX

Body Style display: Wheat background

Segment Style: Controls the Segment labels.

MSH SEGMENT

2071298-
CLIA number: 2101058230 Path Lab Name: TheranostixInc.  Message control ID: 18937452
Medical Record Social Security
Number: IO Number: Hame-Last: 000K
Name-First: OO0 Name-Middle: Ethnic Group:
Race 1:

Segment Style display: shown in navy blue and white font.

Item Header Style: Controls the Pathology Report Headers.
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Path Text Diagnosis [

Path Clinical History

CEB7 B"MALIGMNANT NEOPLASM of overlapping sites of Bladder9CDX
Path Nature of Specimen

Bladder Wash
Bladder Wash

Path Gross Pathology
Gross Info for Site - A : Received 80 mls of cloudy yellow fluid with the patient's name and, "Eladder Wash™ on the vial.

Path Micro Pathology
Microscopic Description :Atypical cells with features compatible with a Low Grade UROTHELIAL CARCINOMA,

Path Comment Section

Other Info
Electronically signed by :Dr.Fatemeh Kalantarpour, on :01/16/2018 02:51:43 PM

Item Header Style display: shown in bold black text

Item Value Style: Controls the text sections of the Pathology Report.

Path Text Diagnosis

Path Clinical History
CE7.8"MALIGMANT NEOFPLASM of overlapping sites of Bladder|9CDX

Path Nature of Specimen
Bladder Wash
Bladder Wash

Path Gross Pathology
Gross Info for Site - A - Received 80 mls of cloudy yellow fluid with the patients name and, "Eladder Wash™ on the vial.

Path Micro Pathology
Microscopic Description :Atypical cells with features compatible with a Low Grade UROTHELIAL CARCINOMA,

Path Comment Section

Other Info
Electronically signed by :Dr.Fatemeh Kalantarpour, on :01/16/2018 02:51:43 PM

Item Value Style display: shown in black

Bookmark Reports

To mark a report for future reference, use the Bookmark option.

1. When areport is open in the Pathology Workbench, select Tools>Bookmark>Add a Bookmark

from the eMaRC Menu Bar.
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i eldaRC Plus
File Administration [Tnnls Help
- % Import HLT I Bookmark 3 Add Bookmark

Go Te/Manage Bookmark

Add a Bookmark option.

e The Bookmark Entry dialog box opens.

Bookmark Entry

OI{ICEII:BI

Bookmark Entry dialog box.

2. Enter a name for the bookmark and click OK.

To go to a previously saved Bookmark:

1. Select Tools>Bookmark>Go To/Manage Bookmark from the eMaRC Menu Bar.
e The Go To/Manage Bookmark dialog box opens.
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'@k Go To/ Manage Bookmark T — e sl

Bookmark Name

=

Prostate
hello
Test 1

Most recently viewed Report (Viewed on 5/9/2018 1:1520 PM )

GeTo | Delete | Rename Close

Go to/Manage Bookmark dialog box.

2. Double-click on the name of the report you want to open.
e The report will open to its location within the imported batch.

To update or delete Bookmarks from your list:

1. Select Tools>Bookmark>Go To/Manage Bookmark from the eMaRC Menu Bar.
e The Go To/Manage Bookmark dialog box opens.
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'm-GoT-qf-ﬁanag_eEmkmark e o— '_ 23

Bookmark Name | Find
| Bookmark

Prostate

hello

Test 1

Most recently viewed Report (Viewed on 5/9/2018 1:15:20 PM )

GoTo | Delete | Rename Close

Go To/Manage Bookmark dialog box.

2. Select the report to edit from the Bookmark list or type keywords into the Bookmark Description

field and click Find.
3. To update the description, highlight the appropriate bookmark, type new text into the

Bookmark Description field and click Update.
4. To delete the description, highlight the appropriate bookmark and click Delete.
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Extracting Information from eMaRC

Export Abstracts and HL7 Messages

A user can export Abstracts and Raw HL7 messages from eMaRC to the location on their personal

computer.

NOTE: privacy and security policies require that any HL7 files containing PHI be stored on

a sure drive.

1. Click the Export abstracts button from the Tool Bar or select File>Extract Abstract/HL7

Reports... from the Menu Bar.
e The Export Abstracts dialog box opens.

I Export Abstracts X

Export file]| Browse...

Select abstracts for export

I Include completed abstracts  Batch ID (leave blank to include all batches):
I Include review abstracts
" Include non-reportable

™ Include holds
[ Include previously exported

[ Include abstracts for follow-back

[ Include ne-cancer terms reports
v Mark abstracts as exported (" Export HLY messages only

(" Export abstracts only
(" Exports abstracts and associated HL7 messages

Export Cancel

Export Abstracts dialog box.

2. Select the location for the export file by clicking the Browse... button, select a file location, fill

out the file name and click the Save button.
3. Click the Export button to create the file of abstracts to send to the repository.
4. To export HL7 Messages, ensure Export HL7 messages corresponding to the abstracts selected

for export or Export HL7 messages only.
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Reports Button

eMaRC has the ability to run reports and provide output in a .csv file (comma-separated values), which
can then be opened in Excel.

1. Click the Reports button in the eMaRC Menu Bar.

e eMaRC Plus - [epathworkbench 3/2/2018 2:18:00 PM, File: FleridaDepartmentofHealth_2.bd, Batch No: 22 - 1 of 2]

#¥ File Administration Tocols Help

Z&a Import HLT  Z& Import Pipe-delimited ||| Open batch {1 Export Abstracts PHINMS Queue -~ Search |;,_N Show/Hide List | = Raw Data

Reports button.

e The Reports dialog box appears.

Select a report from below and click Run

ility Submission Status Report
Facility Submission Status Report By Month
Facility Submission Status Report By Day
Facility Submission Status Report By Week
Display Type
Facility Submission Report by CLIA

Run Report Export Report Data Close

Reports dialog box.

2. Highlight the report you want to run:

e Facility Submission Status Report: counts the number of reports sent by each facility in a
specified date range.

o Facility Submission Status Report by Month: lists the number of reports sent by each facility
in a specified date range by calendar month.

e  Facility Submission Status Report by Day: lists the number of reports sent by each facility in
a specified date range by daily submissions.

e  Facility Submission Status Report by Week: lists the number of reports sent by each facility
in a specified date range by weekly submissions.

o Display Type Report: list select items and defaults from the Abstract Display.

e  Facility Submission Report by CLIA: list the number of reports sent by CLIA number.

Access users only have “Display Type” as the available report to run.

Page 53 of 57



User Guide:
eMaRC Plus v7.0

1. Highlight the report you want to run and click the Run Report Data button.
e The Date Range dialog box opens.

Enter date range:

| 3/ s2mie ~| | 3782018 |

ok | Cancel |

Date range selection.

2. Choose a date range and click Ok.
e The Report will open in a Print Preview window.
3. Click the Print button in the top left corner of the Print Preview window.

nl.l

ép' Em-mu Close

Print Button in Reports Print Preview.

Save a Report as a Comma-Separated Value (.csv) File

1. Highlight the report you want to run and click the Export Report Data button.
e The Date Range dialog box opens.

2. Choose a date range and click Ok.
e The Save As... dialog box will appear.

3. Choose location and name for file and click Save.

4. Navigate to save location and open .csv file.
e List will open in Excel.
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0D R -

Insert Page Layout Formulas Data

s -]

@ e

L ]
FacilitylD Facility MonthRe MonthFol Total Reportab MNonrepor NoCancer Heme Test
21D10582 21D10582 201802 Feb 2018 2 2 0 0 0
4 Total 2 2 0 0 0 0

Reports .csv file.
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Printing Pathology Reports

Print Pathology Report onto Paper
There are two ways to print full pathology reports:

1. To print one report at a time: Open a pathology report and click the Print button in the
Workbench.
e Select margin and paper information.
e Review preview, then click Print.

2. To print a batch of reports: Run a search query for reports you wish to print. Click
e Select margin and paper information.
e Review preview, then click Print.

Print Abstract onto Paper

Open a report and click the Print button in the abstract.

Print a Report to .xps or .pdf File
To print a report to .pdf or .xps file, you will need to change the default printer on your computer.

1. Click on your computer Start Menu from your tool bar.

Registry Plus

Settings

Skype

Skype for Business 2016

i =

Windows Start Menu.
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From the right hand side of the menu, select Devices and Printers or for newer versions of

windows you may have to go through the control panel or settings.

[=2] All Control Panel ltems

=~ 4 [EZ > Control Panel + All Control Panel ltems »

Adjust your computer's settings

1:-‘ Administrative Tools
:g Color Management
@ Default Programs

Devices and Printers option.

@ AutoPlay

l-;.:._! Configuration Manager

U Dell Touchpad

(]

v O Search Control Panel

View by: Largeicons ¥

Backup and Restore

Windows 7) .%‘ BitLocker Drive Encryption
(Wi y ]

g Credential Manager Date and Time
,.J'_ Device Manager &® Devices and Printers

3. To print to a .xps file, under Printers and Faxes, right click on the icon for Microsoft XPS
Document Writer and select Set as default printer.

i% Devices and Printers

«
Addadevice  Addaprinter  Seewhat's printing
- Devices (9)
Dell USE Entry Dell USE Optical Jabra UC VOICE
Keyboard Mouse 5508
< Printers (11)
ATL-32310n ATL-3432 on ATL-3467 on

PSP-ATL3.cdc.go  PSP-ATL3.cdcgo  PSP-ATL3.cdc.go
v v v

==

Microsoft ¥PS Document Writer  Model:
Category:
Status:

=

Set default printer.

“ / Fa > Control Panel > All Control Panelltems » Devices and Printers »

Print server propertics  Remove device

-

NDLLP-321316 Polycom CX600 Smart Card

= 2

ATL-4432 on CDC PDF Writer

psp-atidcde.gov

Fax

Microsoft XPS Document Writer v4
Printer
0 document(s) in queue

()

v O Search Devices and Printers

® X

2 L

.y

—
SMB2240W SyncMaster TSSTcorp
2243BW/2243BW DVD+-RW
X SyncMaster SU-208CB
Magic CX2243...

ST &N

Sce what's printing
Set as default printer

Printing preferences

<= LT

Microsoft Print
to PDF

Microsofi
Document

Printer properties
Creste shortcut

& Remove device

Troubleshoot R

Properties

printer was changed successfully.

g

default.

A green checkmark will appear in the bottom left corner of the icon to indicate default

Print the Pathology Report or Abstract as described above.
When you are finished, change your default printer back to its original setting.
To print to a .pdf file, follow steps 1-5 above. Under step 3, set Adobe PDF printer as the
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